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1. Sampling

2. Deteksi Anomali
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Key objectives:

1. memahami kerangka konsep audit tata kelola teknologi informasi berdasarkan standar

tata Kelola

2. menyusun program audit tata kelola sistem informasi

3. menyusun laporan audit tata kelola sistem informasi

4. melaksanakan pengauditan atas pengoperasian dan pemeliharaan atas sistem informasi

5. melakukan audit atas perolehan, pengembangan, dan implementasi sistem informasi

6. melakukan pengauditan atas keamanan informasi

7. menggunakan Teknik Audit Berbantuan Komputer dalam pengujian pengendalian dan 

pengujian substantif

8. menjelaskan dampak kelemahan pengendalian umum dan pengendalian aplikasi

terhadap peluang terjadinya kecurangan dan kesalahan saji pada laporan keuangan

Here we are
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Last Week Recap 
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Parallel Simulation adalah teknik audit berbasis data yang:
• Menguji keakuratan sistem
• Dilakukan secara independen
• Membandingkan hasil auditor dengan sistem
• Membantu mengidentifikasi kelemahan pengendalian
• Mendukung kesimpulan audit yang lebih andal



Audit Sampling
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Audit Inherent Problem
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The Trilemma

Auditor simply cannot audit everything or everyone

Auditors face practical constraints:
• Organizations often have tons of transactions per 

year.
• Auditors have limited time, usually only a few 

weeks.
• Audit teams have limited manpower.
• Not all data is easily accessible or well-structured.
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Reasonable Assurance

○ The limitation of audit then makes audit provide “reasonable assurance” not 
“absolute assurance”

○ Because examining every single transaction is impossible. Auditors need 
techniques to evaluate the whole population efficiently without checking every 
line item.

○ Therefore, auditors do the sampling
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Sampling

Sampling allows auditors to:

○ Focus on representative items.

○ Make conclusions about the population based on a smaller subset.

○ Use time and staff more effectively.

Instead of checking 1,000,000 transactions:

○ Auditor checks 100 or 200 intelligently selected samples.

○ If the sample is clean → likely the rest is also okay.

○ If the sample shows issues → auditor expands testing.
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Ensures Efficient and Rational Use of Audit Effort
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Traditional Sampling vs. Anomaly-Based Sampling
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Traditional Sampling Anomaly-Based Sampling (Data-Driven)

• Often based on random or 
stratified selection.

• Purpose: ensure coverage and 
representativeness.

• Good for financial statement 
audits or compliance audits.

Limitations:
May miss unusual or risky 

transactions because random 
selection does not prioritize 

anomalies.

• Instead of selecting transactions 
randomly, auditors first search for 
unusual patterns, outliers, or 
inconsistent behaviors.

• These anomalies often indicate 
higher risk of misstatement or fraud.

Examples:
• Extremely high-value transactions
• Repeated round numbers
• Rare vendors suddenly appearing
• Unusual spikes in expenses
• Transactions far from the mean or 

median
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Substantive TestTest of  EffectivenessTest of Design

Sampling in Various Audit Stages

○ Sampling is not only used in substantive testing.

○ It can be applied at multiple stages of the audit life cycle, each with a different purpose. Such:
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Audit Planning

Sampling helps narrow 
down where the auditor 
should focus instead of 
auditing everything.

Auditor only needs a 
few examples to verify 
how the control is 
supposed to work.

Verify the 
data/documents 
needed to ensure that 
the control actually 
worked during the 
audit period.

Sampling identifies 
which items need 
supporting documents 
or verification (often 
focused on 
anomalies).
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How Data Analytics Changes ToE

○ Data analytics and automation are fundamentally changing how auditors conduct the Test of 

Effectiveness (ToE), moving away from traditional, limited testing to comprehensive, 

continuous assurance.

○ Remember, the objective of ToE is to ensure the control is in place

○ Direct observation only confirms the control is operating at the moment of the audit, failing to 

provide assurance of its effectiveness throughout the prior period

○ Effectiveness is best verified by analyzing historical data, which is crucial for proving the 

continuous operation of Application Controls and IT-Dependent Manual Controls (ITDM)

○ Since control effectiveness can be quantitatively measured using this data, auditors can leverage 

analytics to run the test directly on the full data population, not sampled data.

11
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1. Rand/Randbetween
1. =RAND()
2. =RANDBETWEEN()

2. Data Analysis (Random Number Generation & Sampling)
3. Random sampling without duplicate value

1. =INDEX($B$2:$B$10;RANDBETWEEN(1;ROWS($B$2:$B$10));1)

Politeknik Keuangan Negara STAN

Audit Sampling in Excel



Anomaly 
Detection
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. NOT THIS ANOMALY .
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Apa itu Anomali?

anomali/ano·ma·li/ n 1 ketidaknormalan; penyimpangan dari normal; 
kelainan; 2 Ling penyimpangan atau kelainan, dipandang dari sudut konvensi gramatikal
atau semantis suatu bahasa; 3 Tek penyimpangan dari keseragaman sifat fisik, sering
menjadi perhatian ekplorasi (misalnya anomali waktu-lintas, anomali magnetik)

normal /nor·mal /a 1 menurut aturan atau menurut pola yang umum; sesuai dan tidak
menyimpang dari suatu norma atau kaidah; sesuai dengan keadaan yang biasa; tanpa cacat; 
tidak ada kelainan: bayi itu lahir dalam keadaan --; 2 bebas dari gangguan jiwa;

17

Outliers / Irregularities / Exceptions
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Ilustrasi
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Data tinggi badan 

mahasiswa STAN

Data usia

mahasiswa STAN 

tk. III
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TABK – Anomali – Sampling

Pada konteks TABK, sampling yang dimaksud bukan memilih data 
mana yang akan diuji, melainkan menentukan transaksi/dokumen
mana yang akan diuji lebih lanjut (uji substantif)
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Data Analisis Data

(contoh: mencari anomali)

Uji Substantif ke Bukti

(contoh: mencari bukti audit 

atas anomali data)

TABK

Sampling
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Visualisasi Ilustrasi I

20

0

25

50

75

100

125

150

175

200

225



Audit Sistem Informasi

Visualisasi Ilustrasi I - zoomed
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Visualisasi Ilustrasi II

22

0
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24



Audit Sistem Informasi

Visualisasi Ilustrasi I - zoomed
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Ilustrasi Visualisasi Lain
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Yang mana yang anomali?

Apa parameternya?

Apakah anomali tersebut hal buruk?
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Anomali

adalah

temuan!

Anomali adalah

indikasi temuan

yang perlu diteliti

lebih lanjut buktinya



AnalisisDeskriptifdi 
Excel
untuk identifikasi anomali
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Analisis Deskriptif

Analisis deskriptif merupakan metode analisis yang memungkinkan

organisasi audit untuk mengekstrak informasi umum dari data. 

Analisis deskriptif dilakukan melalui analisis statistika deskriptif maupun 

visualisasi atas data historis oleh tim audit.

Analisis deskriptif dilaksanakan dalam rangka memperoleh wawasan (insight), 

gambaran umum, potensi perbaikan, dan/atau risiko yang signifikan

mengenai kondisi proses bisnis

Analisis deskrptif dapat digunakan untuk deteksi anomali
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Analisis Deskriptif:
Statistik

Politeknik Keuangan Negara STAN
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Enable Analysis ToolPak Add-ins di Excel

1. Pilih File -> Options

2. Pada Add-ins, pilih Analysis ToolPak dan klik tombol Go.

3. Centang Analysis ToolPak dan klik OK.

4. Pada Data tab, di Analysis group, terdapat fungsi Data Analysis.
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Analisis Deskriptif:
Statistik

Politeknik Keuangan Negara STAN
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Analisis Deskriptif: Statistik

A. Pilih Kolom yang akan dianalisis (dalam hal ini kolom E 
yang berisi data Penjualan)

B. Output Range: Tempat dimana akan meletakkan hasil 

statistik deskriptifnya

C. Berikan centang Summary Statistics dan Confidence 
Level

DATA -> ANALYSIS -> DATA ANALYSIS -> Descriptive Statistics

Melakukan Analisis Deskriptif Statistik
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Analisis Deskriptif: Statistik

A. Perhatikan hasil pada tabel sebelah ini

B. Adakah informasi yang menarik dari data tersebut?

Penjualan Nilai 

Mean 63.995.874 

Standard Error 23.331.893 

Median 16.985.636 

Mode -

Standard Deviation 752.430.931 

Sample Variance 566.152.306.639.374.000 

Kurtosis 714 

Skewness 26 

Range 21.953.776.914 

Minimum -

Maximum 21.953.776.914 

Sum 66.555.709.192 

Count 1.040 

Confidence Level(95,0%) 45.783.002 

Hasil Statistik Deskritif

Identifikasi Hasil Analisis Deskriptif Statistik
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○ Dari data statistik deskriptif tsb, kita bisa
memperkirakan dimana letak outliers, caranya:

• Rules of Thumb: Outliers umumnya berada
pada 3x (+/-) standard deviasi dari nilai rata-
rata

• Contoh: dari tabel disamping, range outliers 
terletak pada di bawah (-2.464.537.261) atau di 
atas 2.607.376.041

• Perhatian:
untuk data yang digunakan berisi data yang sangat ekstrim 
sehingga Rules of Thumbs di atas menjadi tidak dapat 
digunakan secara tepat

Analisis Deskriptif: Statistik

Penjualan Nilai 

Mean 63.995.874 

Standard Error 23.331.893 

Median 16.985.636 

Mode -

Standard Deviation 752.430.931 

Sample Variance 566.152.306.639.374.000 

Kurtosis 714 

Skewness 26 

Range 21.953.776.914 

Minimum -

Maximum 21.953.776.914 

Sum 66.555.709.192 

Count 1.040 

Confidence Level(95,0%) 45.783.002 

Identifikasi Hasil Analisis Deskriptif Statistik
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Analisis Deskriptif:
Visualisasi

Politeknik Keuangan Negara STAN
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○ Mengetahui Distribusi Data Berdasarkan Range Data | Membuat Histogram

36

Histogram

1. Add in Data Analysis (Histogram)

2. Bar Chart

Menyorot Data -> Insert -> Histogram

Setting Bin: Format Axis
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○ Analisis Hasil Histogram: Distribusi Normal
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Histogram
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○ Analisis Hasil Histogram: SKEWNESS

38

Histogram
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○ Analisis Hasil Histogram: KURTOSIS
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Histogram
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○ Scatterplot Menggambarkan hubungan antara 2 (dua) variabel kontinu (continuous variable).
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Scatterplot

Outliers

Membuat ScatterPlot:

Menyorot Data -> Insert -> Scatterplot
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○ Boxplot Menggambarkan Sebaran Nilai Tiap Kategori
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BoxPlot

Membuat BoxPlot:

Menyorot Data -> Insert -> BoxPlotOutliers



Bendford’sLaw
untuk identifikasi anomali

42Politeknik Keuangan Negara STAN

Nigrini, M. J. (2012). Benford’S Law: Applications For Forensic Accounting, 

Auditing, And Fraud Detection . New Jersey: Wiley.
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Benford’s Law
Untuk Mendeteksi Anomali

Politeknik Keuangan Negara STAN

Nigrini, M. J. (2012). Benford’S Law: Applications For Forensic Accounting, 

Auditing, And Fraud Detection . New Jersey: Wiley.



Sejarah
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Simon Newcomb

"That the ten digits do not occur with equal 
frequency must be evident to anyone making 
much use of logarithmic tables, and noticing how 
much faster the first pages wear out than the last 
ones. The first significant figure is oftener 1 than 
any other digit, and the frequency diminishes up 
to 9." 

Frank Benford

Rediscovered by Frank Benford: ‘The Law of Anomalous Numbers’ (1938)

P(d)= log10[1 + 1/d] first-digit distribution

Politeknik Keuangan Negara STAN
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Data 1 2 3 4 5 6 7 8 9
River 

areas

31.0% 16.4 10.7 11.3 7.2 8.6 5.5 4.2 5.1

Base

ball

32.7 17.6 12.6 9.8 7,4 6.4 4.9 5.6 3.0

magazi

nes

33.4 18.5 12.4 7.51 7.1 6.5 5.5 4.9 4.2

Power

s of 2

30 17 13 10 7 7 6 6 5

20 

tables

30.6 18.5 12.4 9.4 8.0 6.4 5.1 4.9 4.7

 half -

lives

29.6 17.8 1.7 10.5 9,9 4.8 5.2 5.2 5.2

Benfor

dLaw

30.1 17.6 12.5 9.7 7.9 6.7 5.8 5.1 4.6 Random street addresses

Politeknik Keuangan Negara STAN



Analisis menggunakan Benford kemungkinan akan berguna ketika:

• Data set merupakan angka dari hasil kombinasi matematis. Contohnya saldo piutang (jumlah
penjual dikali harga), saldo utang (jumlah pembelian dikali harga) 

• Data level transaksi – tidak perlu sampel. Contohnya disbursement, penjualan, beban
• Data set besar – lebih banyak observasi lebih baik. Contohnya data transaksi satu tahun penuh
• Akun-akun yang sesuai – ketika nilai mean lebih besar dari median dan memiliki skewness positif. 

Contohnya pada sebagian besar data set akuntansi

46

Dan kemungkinan kurangbergunaketika:

• Data set terdiri dari nomor yang ditetapkan. Contohnya nomor cek, nomor tagihan, kode pos

• Angka dipengaruhi oleh pikiran manusia. Contoh harga yang diatur dengan psychological 

threshold (misalnya Rp99.900), penarikan dana di ATM yang telah diset nilai default penarikannya

• Akun dengan jumlah angka spesifik yang besar. Contoh akun yang secara spesifik digunakan

untuk merekam pengembalian dana sebesar Rp1.000.000

• Akun dengan batasan minimum atau maksimum. Contohnya akun aset tetap yang memiliki

batasan minimum berupa batasan minimum nilai kapitalisasi

• Tidak ada transaksi yang direkam. Contohnya pencurian, suap, kecurangan kontrak

Politeknik Keuangan Negara STAN



Penggunaan Benford’s Law
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Ketidakcocokan suatu data set terhadap Benford’s Law merupakan indikator adanya: 

(1) data set yang tidak lengkap

(2) sampel tidak merepresentasikan populasi;

(3) pembulatan data yang berlebihan;

(4) kesalahan data; atau

(5) batas kesalahan maksimal (α) yang terlalu tinggi. 

Politeknik Keuangan Negara STAN



Thank You


